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Killing two birds with one stone...

¢ From a the SANSA-Notebooks github repository
<https://github.com/sansa-stack/sansa-notebooks>

¢ Requirements: % Only 5 commands:

> git clone https://github.com/sansa-stack/sansa-notebooks
dOCker cd sansa-notebooks/

> docker-compose make

make up

make load-data

Goto: http://localhost/
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SANSA: Motivation

% Abundant machine readable structured information s
available (e.g. in RDF)

> Across SCs, e.g. Life Science Data
> General: DBpedia, Google knowledge graph
> Social graphs: Facebook, Twitter

% Need for scalable querying, inference and machine learning
> Link prediction :
> Knowledge base completion
> Predictive analytics
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Social Networks as Graphs

http://www.touchgraph.com/assets/images/TouchGraph%20Hashable%20SXSW.png TouchGraph
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Knowledge Graphs

** Modelling entities and their Barack Obama Joe Biden

re I a t i O n S h i p S ! vicePresident ====p- “‘.‘

.\ 3

* Analysis:  finding  underlying @r /g)
N\

party

structure of graph e.g. to predict /
unknown relationships Democratic Party f@
s Examples: Google Knowledge pany/
Graph, DBpedia, Facebook, /
YAGO, Twitter, Linkedin, MS @)

Academic Graph, WikiData Bl Clinton Al Gore
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Motivation

¢ Over the last years, the size of the Semantic Web has

increased and several large-scale datasets were published
> As of August 2018

Source: LOD-Cloud (http://lod-cloud.net/ )
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Motivation

¢ Over the last years, the size of the Semantic Web has
increased and several large-scale datasets were published
> Based on LOD Stats (http://lodstats.aksw.org/ )

e

~10, OO0 datasets
Openly available

online using Semantic
Web standards

Source: LOD-Cloud (http://lod-cloud.net/ )
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Motivation

¢ Over the last years, the size of the Semantic Web has

increased and several large-scale datasets were published
> Based on LOD Stats (http://lodstats.aksw.org/ )

® , O

~10, OO0 datasets many datasets <

a@

Openly available  RDFized and kept private%;

....(g oo
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online using Semantic (e.g. Supply chain,
Web standards manufacture, ethereum
dataset, etc.]  Source: LOD-Cloud (httpi/flod-cloud.net))
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Motivation

¢ Dealing with such amount of data makes many tasks hard to
be solved on single machines

Source: LOD-Cloud (http://lod-cloud.net/ )
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Motivation

¢ Dealing with such amount of data makes many tasks hard to
be solved on single machines

Vocabulary

Reuse
Find a suitable

vocabulary for
your dataset

Source: LOD-Cloud (http://lod-cloud.net/ )

@ 12
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Motivation

¢ Dealing with such amount of data makes many tasks hard to
be solved on single machines

Vocabulary Coverage
Reuse Analysis
Find a suitable Does dataset

vocabulary for contain
your dataset  necessary

information?

Source: LOD-Cloud (http://lod-cloud.net/ )
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Motivation

¢ Dealing with such amount of data makes many tasks hard to
be solved on single machines

Vocabulary Coverage Privacy
Reuse Analysis Analysis
Find a suitable Does dataset Does dataset
vocabulary for contain contain
your dataset necessary sensitive

information? information?

Source: LOD-Cloud (http://lod-cloud.net/ )

@ 14

Learaaee, Arnyme, Vo Big D Asancs



http://lod-cloud.net/
http://lod-cloud.net/
http://lod-cloud.net/

Motivation

¢ Dealing with such amount of data makes many tasks hard to
be solved on single machines

@

Vocabulary Coverage Privacy Entity
Reuse Analysis Analysis Linking
Find a suitable Does dataset Does dataset Which datasets s

vocabulary for contain contain are good
your dataset necessary sensitive candidates for
. o SR N pS— =
information? information” interlinking” Source: LOD-Cloud (http:flod-cloud.net )
@ 15
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Why Distributed RDF Data Processing?

Tasks hard to solve on single machines (>1TB memory
consumption):

* Querying and processing LinkedGeoData

» Dataset statistics and quality assessment of the LOD Cloud

Vandalism and outlier detection in Wikidata

Inference on life science data (e.g. UniProt, EggNOG, StringDB)
Clustering of DBpedia data

Clustering of user-logs of the Big Data Europe integrator platform for the
creation of user profiles

Large-scale enrichment and link prediction for e.g. DBpedia -

LinkedGeoData



SANSA Stack Vision

Scalable Semantic Analytics Stack (SANSA)

IAREREREERI |} Analytics

Distri-  Semantic
Distributed Distributed In-Memory Processing bution Technology
Machine Learning Stack

In-Memory Computing Framework ' r
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o
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Why combining Big Data and SW?

9

“Big Data” Processing (Spark/Flink)

Semantic Technology Stack

Data Integration

e Manual pre-processing

Partially automated,
standardised

Modelling

e Simple (often flat feature vectors)

6 Expressive

Support for data
exchange

e Limited (heterogeneous formats
with limited schema information)

@ Yes (RDF & OWL W3C
Recommendations)

Business value

6 Direct

e Indirect

Horizontally
scalable

@ Yes

eNo

Idea: combine advantages of both worlds
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SANSA Stack

% It’s core is a processing data flow engine that provides data
distribution, and fault tolerance for distributed computations
over RDF large-scale datasets

% SANSA includes several libraries for creati
> Read / Write RDF / OWL library
Querying library Anaiytcs

Classification
Link prediction

Clustering
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Latent Embeddings

>
> Inference library
> ML- Machine Learning core library

Distributed In-Memory Processing

spatd  @BFlink

http://sansa-stack.net/
® | 19
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SANSA Layers

_I;'.

Distributed In-Memory Processing '
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SANSA: Read Write Layer

Machine Learning

Inference '
Querying l
Distributed In-Memory Processing '
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SANSA: Read Write Layer

* Ingest RDF and OWL data in different formats using Jena /
OWL API style interfaces

¢ Represent data in multiple formats
> (e.g. RDD, Data Frames, GraphX, Tensors) PR

*» Allow transformation among these formats
* Compute dataset statistics and apply functions to URIs,
literals, subjects, objects - Distributed LODStats

- val triples = spark.rdf(Lang.NTRIPLES)(input)

. triples.find(None,

. Some(NodeFactory.createURI("http://dbpedia.org/ontology/influenced")), None)
. val rdf_stats_prop_dist = triples.statsPropertyUsage()



Distributed
data
structures

RDF stats
Tensors/KGE

Quality assessment
R2RML Mappings
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Partitioning strategies

Learaaee, Arnyme, Vo Big D Asancs




SANSA: OWL Support

* Distributed processing of OWL axioms
¢ Support for Manchester OWL & functional syntax

¢ Derived distributed data structures:
> E.g. matrix representation of subclass-of axioms
to compute its closure via matrix operations

val rdd =spark.owl(Syntax.MANCHESTER)("file.owl")
. // get all subclass-of axioms
. val sco = rdd.filter(_.isInstanceOf[OWLSubClassOfAxiom])

24



RDF to Tensors (experimental)

T, is 1if triple (i-th entity, k-th predicate, j-th entity) exists
and 0 otherwise

, Bill Clinton
—presidentOf
——vicePresidentOf
——partyOf Democratic
Party

Al Gore

I~
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SANSA: Query Layer

Machine Learning

Inference l
Querying l

Knowledge Distribution & Representation '
Distributed In-Memory Processing |

k L, Arrtam, 4 o B D Asanrnes
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SANSA: Query Layer

** To make generic queries efficient and fast using:
> |ntelligent indexing
> Splitting strategies
> Distributed Storage
¢ SPARQL query engine evaluation
>> (SPARQL-to-SQL approaches, Virtual Views)

¢ Provision of W3C SPARQL compliant endpoint

e
e
st

e
= s

Wl

. val triples = spark.rdf(Lang.NTRIPLES)(input)

val sparglQuery = "SELECT * WHERE {?s ?p 20} LIMIT 10"
- val result = triples.spargl(sparqlQuery)



Querying via SPARQL &

Partitioning—————

SANSA Eng s

Partitioning [ mm

-
-

-1 5

] 0t ngeciion [l Svariing |ty
It Data Ingestion Sparglifying _ Distributed Data

—» RDF/OWL Layer : : Query Layer : Structures
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Querying via SPARQL &
Partitionine

@& 8 -
= a dbp:Person . Spor‘lz'{ Apache Flink © %
I TTTT ] S
- ‘ R

5 ex:iworkPage 7w . : 2
L] - oy | :
BRIRY Friioning B B e Resuts |
Aemdl Partitioning | IEEEE -
R | 1 S 1

SPARQL

RDF Data

il Data Ingestion | _ Distributed Data

-

SANSA =

Prefix dbp: <!

SPARQL query Prefix ex:<n

4 Create View view_person As
Construct {
: a dbop:Person .

[
SPARQL Algebra '3 eximorkbage - "”§ smmer <, wor
3

. } o
Expression Tree (AET) With FROM view_person ;

?s = uri('http://mydemain.crg/persen', ?7id)
l # = uri(iwork ]

Constrain
?w prefix "http://my-organization.org/user/"

Normalize AET From

person;

@ 29
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SANSA-Datalake

*» A solution for the virtual Big Data integration: Semantic Data Lake
> Directly query original data without prior
transformation/loading
+*» Scalable cross-source query execution (join)
¢ Extensible (programmatically)
> Do not reinvent the wheel: use existing engine connectors
(wrappers)

7@
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Querying via Semantic Data Lake

Data Lake

= S  jpmcu

I O O
00T
HEN
: : : Distributed Data
Databases | :

val result = spark.sparqlDL(query, mappings, confiqg)
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Query Decomposition

SELECT ?b ?fn ?In ?in
WHERE {

' ?b biboisbn ?i .
?b dc:title ?t .

. ?b schema:author ?a .
. ?b bibo:editor ?e .

________________________________

?a foaf:firstName ?fn .
?a foaf:lastName ?In .
?a vivo:Institute ?in .

| ?in rdfs:label ?nl .

?in rdf:type vivo:Institute .

| ?e rdfs:label ?n2 .

SANSA-Datalake

?e rdf:type saws:Editor .

_________

A L s, A, vV Biec; Dhara Aseanrnes

Mappings
(RML)

Relevant Source Detection

Entity: Books
. Data source: Parquet

_Enlity: Authors
. Data source: MongoDB |

Entity: Institutes
H_Data source: Cassandra

—

Entity: Editor -
_ Data source: JDBC |
_Enlity: Reviewer
. Data source: CSV

Data access

ParSet Definitions

I
(=2

=]

o
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Query Planning and execution
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o
W
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Cost Model
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SANSA-Datalake

Mappings
I

Query

o Query

Decomposition

Relevant Entity
@ Extraction

Data Lake

L s, A, vV Bc; Drara Asianyncs

Final Results
o Distributed
Query
Processing

A}
1
1

P
(-

Parallel
Operational
Area (POA)

ParSets

«—1 Config

Relevant
Data Sources
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SANSA: Inference Layer

Machine Learning

Querying '
Knowledge Distribution & Representation '
Distributed In-Memory Processing '
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SANSA: Inference Layer

 The volume of semantic data growing rapidly
* |Implicit information needs to be derived by reasoning
* Reasoning
- the process of deducing implicit information from

existing RDF data by using W3C Standards for Modelling:
RDFS or OWL fragments

; \Q‘a
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SANSA: Inference Layer

Reasoning can be performed in two different strategies:

— The forward chaining strategy derives and stores the
derived RDF data back into original RDF data storage for
late queries from applications (data-driven).

— The backward chaining strategy derives implicit RDF data
on the fly during query process (goal-directed).

The forward chaining strategy has lower query response
time and high load time.

| 0, ALY TG, Bac; rars Al



SANSA: Inference Layer

e Parallel in-memory inference via rule-based forward chaining
* Beyond state of the art: dynamically build a rule dependency
graph for a rule set

— Adjustable performance
—> Allows domain-specific customisation

\
Willy V
] 37
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SANSA: Inference Layer

Parallel RDFS Reasoning Algorithm based on Spark

Filtered RDDs

Intermediate Join
results RDD Single Rule Rule Set

results results

filter

______________ Iterate until fixed point iteration [ — — — — — — — — — — — — — —
@ 38
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SANSA: Inference Layer

Some RDFS inference rules

* (XRY), (RsubPropertyOf Q) — (XQY)
e (XRY), (Rdomain C) = (X type C)
 (Xtype C), (CsubClassOf D) = (X type D)

| G, ALYING Bic: D ___



SANSA: Inference Layer
N S
RDFS rule -

s rdf:type x
5 rdf:type
xrdfs:subClassOfy'_} ypey

dependency graph J

(S/m,O//'fleOy p rdfs:domain X 5 rdf:type x ,0 rdfs:range x F» 0 rdfitype x
spo [\ * 5po [\
\ spo x rdfs:subClassOf y
> sqgo > x rdfs:subClassOf z

p rdfs:subPropertyOf g

vy

p rdfs:subPropertyOf g
g rdfs:subPropertyOf r

y rdfs:subClassOf z

= p rdfs:subPropertyOf r

(&
N—
—

41
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SANSA: Inference Layer
Some OWL Horst Rules:

e powlinverseOfq,vpw—=wqgyvVv
e powlinverseOfq,vgw —=wpyv

7@
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graph (simplified)

p rdfs:subPropertyOf q

,Spo —+sqo
prdftype owl: TranstiveProperty
p rdf:type owl:SymmetricProperty vpu
VPpU = upvVv Wpv
= upv

44



SANSA: Inference Layer

* SANSA-Inference Layer support RDFs and OWL-Horst
reasoning in Triples and OWLAxioms

* Triple based forward chaining:

// load triples from disk
val graph = RDFGraphLoader.loadFromDisk (spark, input, parallelism)

val reasoner = new ForwardRuleReasonerOWLHorst (spark.sparkContext)

// compute inferred graph

val inferredGraph = reasoner.apply(graph)

A .
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SANSA: Inference Layer

Axiom based forward chaining:

// load axioms from disk
var owlAxioms = spark.owl (Syntax.FUNCTIONAL) (input)
// create reasoner and compute inferred graph
val inferredGraph = profile match {
case RDFS => new ForwardRuleReasonerRDFS (spark.sparkContext,
parallelism) (owlAxioms)
case OWL HORST => new
ForwardRuleReasonerOWLHorst (spark.sparkContext, parallelism) (owlAxioms)
case => throw new RuntimeException("Invalid profile: '" +

profile + "'")

}
46



SANSA: ML Layer

Inference

Querying l
Knowledge Distribution & Representation '
Distributed In-Memory Processing '

) 47
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SANSA: ML Layer

+*» Distributed Machine Learning (ML) algorithms that work on
RDF data and make use of its structure / semantics
* Algorithms:
> Graph Clustering
m Power lteration,
m BorderFlow,

m Link based
m Modularity based clustering

> Association rule mining (AMIE+ = mining horn rules from RDF
data using partial completeness assumption and type
constraints)

> Qutlier detection
® > KG Kernels
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RDFt
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—vicePresidentQf
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Link prediction Classification
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RDF By Modularity Clustering

A Hierarchical clustering method
Starts with each vertex in its own community
Iteratively join pairs of community choosing the one with

greatest increase in the optimizing function Q

— Optimization function identifies the significant community
structure

The cut off point maximal value of Q.

Scales as the square of the network size

RDFByModularityClusteringAlg(spark.sparkContext,
numIterations, input, output)

spark.stop

— |
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Power Iteration Clustering

* Simple and fast version of spectral clustering technique

e Efficient and scalable in terms of time O(n) and space

* Applying Powerlteration to the row normalized affinity
matrix

* Partitioning clustering algorithm

— Outputs one-level clustering solution
val lang = Lang.NTRIPLES
val triples = spark.rdf(lang)(input)
val graph = triples.asStringGraph()
val cluster = RDFGraphPowerIterationClustering(spark, graph,
output, k, maxIterations)
;Niy cluster.saveAsTextFile(output)

51



BorderFlow Clustering

local graph clustering algorithm

Designing for directed and undirected weighted graphs
Clusters in BorderFlow:

Maximal intra-cluster density

Minimal outer-cluster density

val lang = Lang.NTRIPLES
val triples = spark.rdf(lang)(input)
val graph = triples.asGraph()

val borderflow = algName match {
case "borderflow" => BorderFlow(spark, graph, output, outputevlsoft, outputevlhard)
case "firsthardening" => FirstHardeninginBorderFlow(spark, graph, output, outputevlhard)
case _ =>

throw new RuntimeException("'"™ + algName + "' - Not supported, yet.")
}
)
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Link Based Clustering

Hierarchical link clustering method

Bottom up approach of hierarchical called the
“agglomerative”

Clusters are created recursively

The similarity S between links can be given by e.g. Jaccard
similarity

val lang = Lang.NTRIPLES

val triples = spark.rdf(lang) (input)
val graph = triples.asStringGraph()

AlgSilviaClustering(spark, graph, output, outputeval)

53



>)4> o
)

o)

DBSCAN Clustering

Clustering of POls on the basis of spatially closed
coordinates.

POls located in same geolocation are clustel

Input

RDF Data

DBSCAN Algorithm

of their categories. . o,
Cluster 1 oo 9 ooo ¢ Cluster 2
0
val lang = Lang.NTRIPLES Q 9°o Q' cos saton
val triples = spark.rdf(lang) (input) SRAC ©  resuran

val graph = triples.asStringGraph() ////T\\\\‘ Q am

AlgSilviaClustering(spark, graph, output,

RDD[Cluster

RDD{Cluster RDD[Cluster

1 List(Triples)] 2,List(Triples)] 3,List(Triples)]

utputeval)

ARSI, APpLVING, Bec; Dhars Avaanincs
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Numerical Outliers Detection

Detecting numerical outliers in large RDF dataset.

Spark minHashLSH used to create the cohort of similar class.
A scalable approach to find the outliers in a massive dataset.
Numerical outliers detected in the data are useful for
improving the quality of RDF Data

7@
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RDF Graph Kernels

Given an RDF graph constructing a tree for each instance and
counting the number of paths in it.

Literals in RDF can only occur as objects in triples and therefore
have no out-going edges in the RDF graph.

Apply Term Frequency-Inverse Document Frequency (TF-IDF)

for vectors.
1. val rdfFastGraphKernel = RDFFastGraphKernel(spark, triples,

"http://swrc.ontoware.org/ontology#affiliation")
2. val data = rdfFastGraphKernel.getMLLibLabeledPoints

3. RDFFastTreeGraphKernelUtil.predictLogisticRegressionMLLIB(data,
A

4, iteration)

Bircs D Asaay
— |
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Rule Mining

Association Rule Mining under Incomplete Evidence (AMIE)
Atoms : are facts with the subject and object position
substituted with variables e.g. (isChildOf(?a,?b))

Rules : made up of atoms having a head (one atom) and the
body (multiple atoms)

The body (B,.....B,}  predicts the head ()

A Rule can be written as
BiANBsA...\NBy=r(r, y)

OR B = r(r,y)



Interactive SANSA in your Browser

val input =

val propertyDist =

println{"%table Property Distribution\tFrequency\n "

"hdfs://namenode:8020/data/rdf .nt"
val triplesRDD = NTripleReader.load(spark, JavaURI.create{input))

PropertyUsage({triplesRDD, spark).PostProc()

.map(f == f._1l.getLocalName+ "\t" + f._2)

input: String = hdfs://namenode:8828/data/rdf.nt
triplesRDD: org.apache.spark.rdd.ROD[org.apache.jena.graph.Triple] = MapPartitionsRDD[27] at map at NTripleReader.scala:39

propertyDist: Array[String] = Array(author

2, deathPlace

B ol | | e | [ & |~ | settings~
@ author source 0 description date @ permission \ \
@ gallery width @ inline artist year :
version @influenced otherversions @ deathPlace
givenMame @ hidetitte @ wikidata

@

L, Arpwama, Y

2, givenName

o B Drama Asannes

25, source
2, hidetitle 1, wikidata

18, description
1, gallery

FINISHED [>

+ propertyDist.mkString{"\n"}}

17, date 11, permission 4, versionm 2, influenced 2,

1, width 1, inline 1, artist 1, year 1)
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BDE & General Integration

*¢ SANSA = Scala / Maven Repositories based on Spark / Flink
¢ Easy to include both in BDE platform and any Spark / Flink
environment

Application Support layer

Resource
manager
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SANSA Planning and Pulse

** SANSA 0.6 in June 2018, releases every 6 months
¢ Apache Open Source License
** Project activity:

> Contributors (at least one commit): 17

> Commits per day: 5.9 - Commits previous year: 2175
> Github stars (all repos): 187

NOV 8, 201 5 - NOV 7, 201 8 Contributions: Commits ~

2016 Apr Juty October 2017 Apri July October 2018 Apri July October
k
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Conclusions and Next steps

*» A generic stack for (big) Linked Data
> Build on top of a state-of-the-art distributed frameworks (Spark, Flink)

*» Out-of-the-box framework for scalable and distributed
semantic data analysis combining semantic web and
distributed machine learning for (1) querying, (2) inference
and (3) analytics of RDF datasets.

*» Next steps

> Support for SPARQL 1.1 and other partitioning strategies
(Query Layer)
> Backward chaining and better evaluation (Inference Layer)
?\/ > More algorithms and definition of ML pipelines (ML Layer)
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